
Welcome to the new quarterly BG e-Newsletter. 
Here you will find the latest product updates, new release information, industry news and 

Honeywell Forge for Industrial solution articles.

In this issue,

• Introduction to UniSim Tutor Web Server

• Recommended UniSim Design OTS builds

• Learn how to save engineering time with new UniSim Design workflow enhancements

• Learn about enhancements to PBO provided in PBM R510

• DynAMo Metrics and Reporting HF5, ACM 321.2 HF12, and DynAMo Operations Suite
R230.2 Patch 2 are available for download

• Profit Suite R502.1, PS R442.1 Patch001, and TaiJI PID R310.2 Patch are now available for
download

And don’t forget to watch our latest video on the new Honeywell Forge for Industrial offering to 
see how it can transform your business today.

If you have any questions or comments, don’t hesitate to contact us.

GlobalBGPDeliveryCentre@honeywell.com

READ UNISIM DESIGN ARTICLES

UNISIM® DESIGN SUITE

• User Workflow Improvements
• Save Engineering Time

> Try the Knowledge Base <

:: If you received this Honeywell notification from an associate and would like to 
receive your own copy, please subscribe > Get the latest news in your inbox! 

UPCOMING PRODUCT RELEASES | CONTACT 

READ UNISIM COMPETENCY ARTICLES

PROFIT™ SUITE

• Summary of 4Q19 Profit Suite
and CPM articles

PROFIT™ BLENDING AND MOVEMENT

• Profit Blend Optimizer
enhancements in PBM R510

READ PROFIT SUITE ARTICLES

READ PBM ARTICLES

Training Classes OnLine Support

Find the upcoming
training to improve
your knowledge.

SAVE
YOUR
SPOT

- Create a Support Request online.
- Monitor your Support Request
- Visit the Request Help page.

Webinars

WATCH OUR ON-DEMAND 
WEBINARS

Get more knowledge!

READ DYNAMO ARTICLES

DYNAMO® ALARM AND OPERATIONS

• Usability enhancements with
quality improvements

• DOS R230.2 Patch 2 is available
for download

UNISIM® COMPETENCY SUITE 

• UniSim Tutor Web Server
• Recommended USD builds

mailto:GlobalBGPDeliveryCentre@honeywell.com
https://honeywellprocess-community.force.com/hpsservice/Community_PublicSearch
https://www.honeywellprocess.com/en-US/support/Pages/newsletters.aspx
https://www.honeywellprocess.com/en-US/training/Pages/default.aspx
https://www.honeywellprocess.com/en-US/training/Pages/default.aspx
https://honeywellprocess-community.force.com/hpsservice/Submit_Request_Form
https://honeywellprocess-community.force.com/hpsservice/Request_Help
https://www.honeywellprocess.com/en-US/contact-us/customer-support-contacts/Pages/default.aspx
https://gateway.on24.com/wcc/gateway/honeywell20088/1381276


   
 

- 2 - 

UniSim® Competency Suite 

UniSim Competency Suite is the most comprehensive suite of Operator Competency and Training tools available today. UniSim Tutor is part of 

the UniSim Competency Suite of applications. UniSim Tutor is a knowledge-based assessment application used to train and evaluate Operators' 

understanding of their plant's processes. Results of these assessments can be configured to be automatically stored in UniSim Curriculum as 

part of a competency management solution. 

To access other information about UniSim Competency Suite, customers are invited to register to use the Knowledge Base. Please follow this 

link for full details. 

Introduction to UniSim Tutor Web Server 

UniSim Tutor is a knowledge capture and propagation tool used to help process operators improve their problem diagnosis and trouble 

shooting skills. For easy access the student interacts with the tool using a web browser. The content for the trainee i.e. the exercises are 

created by the content developer using the UniSim Tutor desktop application which, for security reasons, is stored in an SQL database. UniSim 

Tutor accesses the SQL database using the UniSim Competency Suite Server. The trainee taking an exercise interacts with the content using a 

web browser for which it is necessary to install an additional server i.e. the UniSim Tutor Web Server. Installing UniSim Tutor Web Server will 

automatically turn on all the Internet Information Services (IIS) that are required to serve up the Tutor website to connected clients. If IIS is 

not enabled, then it can be enabled from control panel Windows feature turn on and off utility. 

Both UniSim Tutor Web Server and UniSim Competency Suite Server only need to be installed on one machine, it is possible to install the 

servers on a single machine or two separate machines. Client machines only need a browser and a URL to access the Tutor content for training 

no other install is required for client access. 

UniSim Web Tutor – Single Server Installation 

  

 

 

 

This is the simplest method to configure Tutor setup as UCS server & Tutor Web server will be installed on the same machine. Single server 

setup works in both Domain as well as workgroup. Tutor Web application can be accessed from the client computer using a web browser with 

the following URL https://localhost/tutor or https://Machinename/tutor. Honeywell recommends enabling SSL for the Tutor website however 

it will still function in a non-secure setting (using http). 

UniSim Web Tutor – Two Server Installation 

 

 

 

 

 

To distribute the load in a Tutor Web installation, it is possible to install server components on different machines. These machines must be in 

domain, which will provide enhanced security to allow credentials to be passed between servers. NOTE: Two server setup is not possible if the 

machines are in a workgroup. 

Machine “A” 

UniSim Competency Suite (UCS) 

Server 

UniSim Tutor Web Server 

Client 

Machine 

Machine “A” 

UniSim Competency Suite 

(UCS) Server 

 

Machine “B” 

UniSim Tutor Web Server 

Client Machine 

https://honeywellprocess-community.force.com/hpsservice/Search_Knowledge_Base#How-can-I-register-at-honeywellprocess-com
https://honeywellprocess-community.force.com/hpsservice/Search_Knowledge_Base#How-can-I-register-at-honeywellprocess-com
https://localhost/tutor
https://machinename/tutor
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The machines hosting the servers (UCS server, Tutor Web server) and all the clients must be in same domain. UniSim Competency Suite 

installation guide has the detailed steps (like Enabling delegated authentication, IIS application Pool identity configuration, IIS authentication 

section configuration, Enabling SSL & security configuration) which are mandatory for configuring Tutor Web in distributed server mode. Tutor 

Web application can be accessed from any client machine using web browser https://webserver_machinename/tutor. 

Unisim Design OTS build recommendation 

TAC has detected that some customers are experiencing instability with a subset of USD OTS builds. The builds known to be affected are R450 

OTS 20558-20571 and R460 OTS 21509-21515. Customers using these builds are advised to contact us. Check by looking at the status display in 

USO, right click the USD engines, select “properties” to view the case build details (Engineer User Role necessary). 

 

Operator Competency Software Updates available 

Operator Competency Software Updates are now available for currently supported versions of UniSim Competency Suite 

UniSim Competency Suite R470 Patch Releases... (no patch released yet) 

UniSim Competency Suite R461 Patch Releases… (no patch released yet) 

UniSim Competency Suite R460 Patch Releases… 

The latest patch for UniSim® Competency Suite R460 is Patch 5 (released on March 20, 2019). The main corrections are described in the 

previous quarter newsletters. 

UniSim Competency Suite R452 Patch Releases... 

The latest patch for UniSim® Competency Suite R452 is Patch 4 (released on March 27, 2019). The main corrections are described in the 

previous quarter newsletters. 

UniSim Competency Suite R451 Patch Releases... 

The latest patch for UniSim® Competency Suite R451 is Patch 2 (released on April 11, 2018). The main corrections are described in the previous 

quarter newsletters. 

Article submitted by – Rakesh Kumar V G, HPS Technical Support – Operator Competency. 

Back Home 

https://webserver_machinename/tutor
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UniSim® Design Suite 

 

New Usability features in UniSim Design R470 

This month’s article describes some of the changes made in UniSim Design R470 to improve usability. 

All customers, who have not yet done so, will need to register to use the Knowledge Base links in this article. Please follow this link for full 

details. Having registered please visit https://www.honeywellprocess.com/support and Login before following the links in this article: 

Full details of UniSim Design R470 may be found in the Knowledge Base here: UniSim Design Suite R470 Information 

An archive of all the UniSim Design Guardian Newsletter articles can be found here. 

The following features are covered: 

• Customizable Standard Conditions & what properties they affect 

• New ‘…Flashed@ Std Cond’ stream Correlations 

• Object Description – flowsheet label improvements 

• New ‘Stream Thickness Scheme’ 

• Calc Order Tool reporting improvements 

• Flowsheet lock Improvements 

• Recycle and Adjust Improvements 

• Case Scenario Manager Improvements 

Customizable Standard Conditions & what properties they affect 

Historically the Standard Conditions in UniSim Design were fixed and could not be adjusted, now the user may set them explicitly, by selecting 

on the UniSim Design Preferences (Tools > Preferences menu option): 

Either 

• Default: 1 atm and 15C (If C or K temperature units are in use) or 60F (F or R Temperature units) 

 

Or 

• User specified from Simulation tab Basis Options page in Preferences 

https://honeywellprocess-community.force.com/hpsservice/Community_PublicSearch?KaUrl=How-can-I-register-at-honeywellprocess-com
https://www.honeywellprocess.com/support
https://honeywellprocess-community.force.com/hpsservice/Search_Knowledge_Base#UniSim-Design-R470-Information
https://honeywellprocess-community.force.com/hpsservice/Search_Knowledge_Base#BGP-Newsletter-Archive
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Note as well another change in UniSim Design R470 - now the location of the PRF file (saved preferences) is shown explicitly 

For more information about standard conditions in UniSim Design please see the Knowledge Base article 71229 - What are the Standard 

Conditions in UniSim Design? 

Which stream correlations are affected? 

A change in standard conditions affects all the properties on the Conditions and Properties pages of the stream which include the keyword 

‘Std’ but not the keyword ‘ideal’. For example, ‘Std. Gas Flow’ is affected because this uses the density of an ideal gas at the specified standard 

conditions but ‘Std Ideal Liq Vol Flow’ is not affected because this is based on the weighted average density calculated using the ‘Ideal Liquid 

Density’ property of each component. 

 

 

 

 

 

 

 

 

 

. 

For more information please see the Knowledge Base article 71213 – “How are the various volume flow properties calculated?” 

Note – full path to 
PRF file now 

shown in R470… 
 

✓

 

 

✓

✓ 

https://honeywellprocess-community.force.com/hpsservice/Search_Knowledge_Base#What-are-the-Standard-Conditions-in-UniSim-Design
https://honeywellprocess-community.force.com/hpsservice/Search_Knowledge_Base
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New ‘…Flashed@ Std Cond’ stream Correlations 

A further change for UniSim Design R470 is the addition of several new stream correlations: 

• Liq. Vol. Flow-Flashed@Std Cond 

• Gas. Vol. Flow-Flashed@Std Cond 

• Act. Vol. Flow-Flashed@Std Cond 

Here the overall stream is flashed to the specified standard conditions and then the total liquid or gas flows are displayed. 

How does this differ from the existing Std. properties? 

For the other ‘..Std.’ properties no flash is done to work out what phases are present at standard conditions. They simply use the COSTALD 

(corresponding states) density (for liquid) or ideal gas molar volume (for gas) to work out what density the stream and each phase would have 

at standard conditions 

For more information please see Knowledge Base article 105214 - New ‘…Flashed@ Std Cond’ stream Correlation”. 

Object Description – flowsheet label improvements 

Object Description is one of the properties that can be shown as the PFD label by using a shortcut key (in this case Shift+R). 

See the Help > Hot-Key List menu option and then look on the PFD page for all the possible Shift+ combinations. Press Shift+N to return to 

Object Names. 

The Object Description may be modified on the Worksheet tab, Notes page of a Material Stream or the Design tab Notes page of a Unit 

Operation. Or select the object on the PFD and press the F2 key to bring up an editing window for Name and Description as shown below. 

If an object does not have a Description entered, then the object Name will show instead when Shift+R is pressed. From UniSim Design R470 

onwards the Name shows in [square brackets] as an indicator that no Description is entered (as shown below). 

A typical use for the Object Description might be to enter the PFD or P&ID tag for given streams/unit operations. Hence giving extra flexibility 

when modelling. 

For more information about “Object Description”, please see the Knowledge Base article 105126. 

  

 
There are many Shift +? 

Combinations for Flowsheet 
label variables 

See Help > Hot Key List > PFD 

https://honeywellprocess-community.force.com/hpsservice/Search_Knowledge_Base#New-Flashed-Std-Cond-stream-Correlations
https://honeywellprocess-community.force.com/hpsservice/Search_Knowledge_Base#Object-Description-PFD-Label
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New ‘Stream Thickness Scheme’ 

In previous versions of UniSim Design, changing the thickness of streams on the flowsheet was possible only by manually adjusting each 

stream object on the PFD. Now users have the possibility of configuring the flowsheet so that streams size automatically based on a selected 

variable (by default the mass flow). 

The Stream Thickness Scheme is available on the PFD toolbar button as shown in the image below. By clicking the red-highlighted button a 

dialogue box appears allowing the user to enable the scheme, configure the variable used and choose the default boundary values for each 

stream icon size. 

 

For more information about the “Stream Thickness Scheme”, please see the Knowledge Base article 99193. 

Calc Order Tool reporting improvements 

The Calculation Order tool enables the user to see the order in which each object on the flowsheet is dealt with by the UniSim Design steady-

state solver. More details can be found in section 11.23 of the User Guide documentation. 

In UniSim Design R470 the tool now shows the total Elapsed Time of each run and percentage of each object’s Cumulative Time against the 

total Elapsed Time. Calc Order Tool results can be displayed on the flowsheet as the label against each object by using the hot key combination 

Shift + J. Press this combination again to toggle to a different result. 

 

  

https://honeywellprocess-community.force.com/hpsservice/Search_Knowledge_Base#How-does-the-present-Flowsheet-Lock-functionality-work-if-there-are-contained-flowsheets-When-using-the-Flowsheet-Lock-UniSim-Design-does-lock-any-contained-flowsheets
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Flowsheet lock Improvements 

Any flowsheet within a UniSim Design model can be locked and hidden to make it impossible to change topology and invisible (including OLE 

access) by making settings on the Lock tab. 

In UniSim Design R470 this feature has been enhanced to allow the user to automatically propagate the lock/unlock signal to contained 

flowsheets. 

 

For more information, please see the Knowledge Base article 105127. 

Recycle and Adjust Improvements 

Recycle 

In UniSim Design R470 two new features have been added to the Recycle. 

• A new algorithm “Exclusive Tear Sets (1981)” has been added to help suggest Recycle tear stream locations 

• The yellow flyby window on the Recycle Sensitivities on the Parameters tab Variables page now shows the Absolute Tolerance that is 

used internally 

 

  

https://honeywellprocess-community.force.com/hpsservice/Search_Knowledge_Base#How-does-the-new-Stream-Thickness-Scheme-introduced-in-UniSim-Design-R470-work
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Adjust 

A simple new Bisection searching method has been added to the Adjust operation. The user needs to enter the range (Minimum and 

Maximum) and then the adjust method simply bisects the range till an answer is found 

 

Case Scenario Manager Improvements 

Several new features were added to the Case Scenario Manager in UniSim Design R470: 

• The user may configure a Scenario to automatically update when a new version of Case is detected 

• A new Check & Update Scenario button has been added which can trigger a scan for newer cases (otherwise this happens 

periodically) 

• A new scaling factor option is available, when setting up variable propagation, that allows multiple variables to be scaled by the same 

factor. 

• Improved filtering – The Object Name Filter checkbox located on the lower bottom corner allows the user to filter the variable 

selection per object instead of entire object class. When the checkbox is checked on, the fourth group Object Name Selecting column 

will be displayed and listed all the objects which have the current variable selected in the third group. The user can decide which 

objects should be selected to show the variable by checking on/off the checkboxes. 

Newsletter Articles 

We aim to provide articles of interest to the UniSim Design user community. If you have any feedback or have suggestions for topics to cover 

here please feel free to contact us; we value your input. 

Article submitted by – Dragos Marin, Ilie Stafie & James Martin, UniSim Design Global Support Team. 

On-demand Webinars 

• Learn How to Auto-Calibrate Kinetic Reactors Using Multiple Datasets  

• Is Tuning & Calibration of Your Reactors 

Back Home 

  

https://honeywellprocess-community.force.com/hpsservice/Search_Knowledge_Base#UniSim-Design-Suite-Contact-Us
https://discover.honeywell.com/Learnhowtoeasilyevaluatecostofyourprojects-5310_03.On-DemandPage.html
https://discover.honeywell.com/UniSimWebinarRefining-5557_03.On-DemandPage.html
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Profit® Blending and Movement Suite 

PBO Enhancements 

Did you know…? Profit Blend and Movement (PBM) R510 provides several enhancements to the Profit Blend Optimizer (PBO) application. One 

of the key enhancements is a new optimization mode – Composite.  

As part of the blend configuration carried out by the engineer, desired blend property control objectives are specified. The blending objectives 

are used by PBO when it carries out the blend optimization calculations.  

The default blend objective is Property Control, which minimizes property off-specification deviation i.e. to bring the blend on-spec. This is 

referred to as control mode.  

In previous versions, the following alternative blending optimization objectives were available:  

• Minimum Cost: to minimize the cost of the blend based on component costs. This is referred to as cost mode.  

• Minimum Giveaway: to minimize property deviation from the low or high specification limit, based on property costs. This is referred 

to as Giveaway mode.  

• Minimum Distance: to minimize deviation from the current target recipe, or from high or low component limits. This is referred to as 

Minimum Distance mode.  

PBO now provides an additional blending optimization objective: 

• Composite (NEW): this combines three objectives (Minimum Distance, Minimum Giveaway and Minimum Cost) into one composite 

objective. This is referred to as Composite mode, and is set as follows:  

Wt_A * MinDist + Wt_B * Giveaway + Wt_C * Cost + Recipe Damping  

where Wt_A, Wt_B and Wt_C are the Composite objective weighting factors for Minimum Distance, Giveaway and Cost respectively.  

Note: The composite blend optimization mode is only available if the NOVA solver is used. The composite blend optimization mode is NOT 

available if the MINOS solver is used.  

PBO blend optimization is carried out in multiple sequential stages, with each stage optimizing for one of the blending objectives. Each 

succeeding stage preserves the optimum achieved in the previous stage, while using any remaining degrees of freedom to optimize for an 

additional objective. The following blending objective combinations may be configured by the engineer:  

• Control - Giveaway  

• Control - Cost  

• Control – Cost - Giveaway  

• Control – Giveaway - Cost  

• Control – Minimum Distance  

• Control - Composite  

For more information on BPM, or any of the PBM applications, please contact your Honeywell Account Manager or your local Application 

Application Support Contact Information: 

• The Americas: rac.support@honeywell.com 

• Europe, Middle East and Africa: bma.support.emea@honeywell.com 

• Asia Pacific: bflex.support.ap@honeywell.com 

Back Home 

mailto:rac.support@honeywell.com
mailto:bma.support.emea@honeywell.com
mailto:bflex.support.ap@honeywell.com
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DynAMo Alarm Suite 

M&R R202.1 Hotfix 5 + ACM R321.12 Hotfix 2 Announcement 

M&R R202.1 Hotfix 5 has been released. The Software Change Notice (with embedded links to media download) has been published to 

HoneywellProcess.com → Documents. 

ACM R321.12 Hotfix 2 has also been released. As this is a small update zip package this has been published to HoneywellProcess.com → 

Downloads. 

Problems Resolved 

M&R R202.1 Hotfix 5 includes the following enhancements: 

• Continuous widget layout in PDF reports 

• Tag details in Alarm Flood report 

• New time range shortcuts 

• Modifying the report schedules created by other users 

• Customizing the display order of KPIs 

• Thresholds for D&E KPIs 

• Symptomatic Analysis report – tabular view 

• Customizing the definition for alarm flood 

 

The following PARs are resolved with this update: 

PAR Issue Description 

RDYNAMO-2079  The “Alarm Properties” icon appears in all the widgets even if D&E connection is not configured.  

1-BLF2KTR  Imported report does not work if a base custom report with the same name exists already.  

1-BQRJMP6  Stale Alarm Over Time report displays multiple entries for the same tag.  

1-BTCNC1X  The criteria of priority change for re-alarming must not be case sensitive.  

1-BLF2KRZ  In some systems, M&R is unable to export the reports to PDF.  

B7J46YZ  Sometimes, the Unmanaged Tags widget shows incorrect data.  

RDYNAMO-2141  Widgets that display trend charts (Ex. Average alarm rate) should not display the aggregate value trend if only one 
Operator Position is selected. (usability issue).  

1-BV5OB3B  Deleting a published report causes the base custom report to disappear from the Custom Report menu. Refreshing 
the M&R webpage brings up the base custom reports back.  

1-BR5CTR5  Enhance Rules Identification to support handling Null values between regular expression characters.  

1-BF9STNB  Enhance Rules identification to support same End of Line Marker (EOM) and outcome of Regular expression for end 
of Column mapping  

BU0XPGB  Scheduled Reports with "Grp by OP" option is not being emailed when stacked report has MFA widget  

1-AO5LUNH  Improvement in Tag Count Check when Tags Asset is moved within a Site  

 

The SCN can be downloaded from the link below which includes a link to download the zip package: 

DynAMo Metrics and Reporting R202.1 Hotfix 5 

https://www.honeywellprocess.com/library/support/Documents/HiSpec/DynAMo-MetricsAndReporting-R202-1-Hotfix5-SCN.pdf
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Note: This update requires DynAMo Metrics & Reporting R202.1 with or without the earlier hotfixes. 

This is a cumulative update that includes DynAMo Metrics & Reporting R202.1 Hotfix 1-4. 

 

ACM R321.12 Hotfix 2 includes the following enhancements: 

• Alarm Help support across firewall (Alarm Help Router) 

• Experion R511 Support 

The following PARs are resolved with this update: 

PAR Issue Description 

778S26S & 1-3HP029F  Alarm help support for NORSOK blocks 

ATTENTION: The resolution for this issue requires Experion R501.6 Hotfix 1. Contact Honeywell Support for the 
installation package. 

1-B4DDCBH  During enforcement, ACM logs the message 'Determine Access Failed to Look Up via ADSI' message as Error in 
the Event Viewer. Change the message type from Error to Warning.  

1-AXE6VJN  For TPN REGPV tags, ACM does not manage the DEVHITP trip point.  

1-BE5E4W1  After installing ACM R321.12, TagSync Reconfiguration fails with the error message “Object variable or with 
block variable not set”.  

1-BUA463R  While migrating asset data from EMB to the new local Asset Model configuration utility, asset names longer 
than 50 characters are truncated.  

1-BV9GS4R  Alarm Help support across firewall  

1-BVQABLL  Console Release operation fails if the size of the base file exceeds 131MB  

 

The update package which includes the SCN can be downloaded from the link below: 

ACM R321.12 Hotfix 2 

Note: This update requires ACM R321.12 with or without hotfix 1 (restricted release only). 

This is a cumulative update that includes ACM R321.12 Hotfix 1. 

If you have any question concerning this Heads-Up Message, then please contact HPS Technical Support 

Back Home 

  

https://www.honeywellprocess.com/library/support/software-downloads/HiSpec/ACM-R321.12-Hotfix2.zip
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DynAMo Operations Suite 

R230.2 Patch 2  

What’s new in this release  

DOI  

• User can view the LR write back tags from the forecast view of the instructions page by clicking the Limit Write 

Tag Detail icon. The Write tags will be displayed in a separate column in the LR Variable Limits page.  

• Forecast view of the limits will now show the completed instructions along with the future values of all the 

instructions based on the selected time range.  

• User can view the Limit Change Details of the instruction by clicking the View Limit Change Details icon in the 

instructions console. You can view the modified values along with details like Last Modified By, Last Modified 

Date, and Actual Start Time. The modified values are highlighted in yellow. Note: The page size in the Limit 

Change Details grid is taken from the filter panel.  

DOM  

• User can now delete a comment alone from deviation analysis in Deviation Summary, Target Summary and 

Monitoring snippet pages.  

DOL  

• A new setting Allow_Appending_OriginAssetName has been introduced in logbook. This setting will allow the user 

to disable the parent asset name from appearing as a prefix for all child asset comments belonging to the same 

parent child hierarchy. 

 

Issues addressed in this patch  

The R230.2 Patch 2 is a cumulative Patch for R230.2. The following table contains issues fixed in R230.2 Patch 2 release. 

For issues fixed in R230.2 Patch 1, refer to the R230.2 Patch 1 SCN. 

PAR ID/Jira ID Description 

1-BZ20PL7 Logbook comments snippets are not getting saved in shift log after browser refresh. 

1-BZD977J Edit icon is appearing even in edit mode of DET snippet and Matrix snippet 

1-BUVHGC2 Delete icon disappears in edit mode of DET snippet. 

1-C2PPTJ9 Not able to multiselect targets and provide reasons. 

RDOS-4375 Not able to add comments for shift in Matrix Snippet if the comment is formatted. This issue is 
observed after navigating away from the page and coming back to the page 

RDOS-4508 System should give a warning if the user leaves the Comments page without saving the 
comments. 

RDOS-4504 The update button is hidden when the comments pop up is maximized and viewed. 

RDOS-4514 When a comment is updated, the focus of the page shifts to the top of the page 

RDOS-4596 Hide Create Standing Order icon in Comments page. 
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RDOS-4956 Formatting of the comments in Matrix Snippet is lost when the report is saved and reopened 
for editing. 

RDOS-4597 Apply Preference icon is not appearing in the Comments page. 

RDOS-4835 Recursive cross-shift summary's hang fire jobs are not getting deleted on deletion of the cross-
shift summary. 

1-BZ7G6XD In shift summary display table, data is missing from the table for a few snippets after 
submission. 

RDOS-4846 Rollup DET with default columns, show error in fetching data in print preview 

RDOS-4955 Additional dialog is being added in Matrix snippet when user clicks edit comment after report 
submission. 

RDOS-4947 In the comments page, performance issue is observed because of memory leak while switching 
the assets multiple times 

RDOS-5056 Sometimes the task page does not load even when there is no load on the system. 

RDOS-4513 Clicking any action (like Save, acknowledge etc.) is causing the grid to move to the first page 
when there are multiple pages in DOM Summary page 

RDOS-4530 The filtering of contributing assets based on target groups is having issues 

RDOS-4561 Split based on shift is creating duplicate deviations. 

RDOS-4999 In the Target Management instruction page, the scroll option is not available when there are 
more records. This behavior is observed only in full screen mode. The page size filter is not 
filtering the page according to the value set. 

1-BYPD5PN If scope security is applied, then Limit Instruction and Standing Order cannot be activated at 
the child level in the hierarchy 

RDOS-4509 Asset sequence under asset list dropdown in any DOS module should be according to the order 
set in the asset hierarchy node 

RDOS-4527 Asset display name should be displayed instead of the Asset Name in the asset drop down in 
copy instruction template page and Operations Alert Client page 
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Profit Suite 

Profit Suite Knowledge Article Quarter: Summary of Articles – 4Q19 (to end December) 

Please refer to the August 2018 BG Newsletter for all the details regarding this Profit Suite Knowledge Article Quarter series and this quarter 

we publish the Summary of Articles for 4Q19 on the portal below: 

 

 

Final note on KAs is the above table shows only the public published articles, however on rare occasions there is a need to share 

internal/confidential KAs within Honeywell and these are not published publicly, although they also have Article ID numbers, which might 

account for gaps and apparent missing article numbers. 
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Profit Suite R502.1 is now available for download 

Profit Suite™ R502 builds on R501 and R500 functionality delivering incremental improvements specifically in Profit Executive (PEx), Profit Web 

Viewer, Profit Suite Engineering Studio, Profit Suite Runtime Studio and Infrastructure (PEx integration with Profit Blend Optimizer (PBO) and 

new Input/Output OPC logging feature). In addition, Flexera licensing has been improved with one time licensing of multiple activation IDs and 

bin file validity extending from one to 4 days. Finally, R502 has a strong maintenance release flavour with over 50 Product Anomaly Reports 

(PARs) fixed. The full details of these new features and functional release specifics/download locations are given below. Please note also, the 

updating of Intuition Core Components to R292. 

Summary of the New Features in R502 

Profit Executive – specifically the following 3 enhancements have been made: 

1. Profit Executive (PEx) has been enhanced to integrate with Profit Blend Optimizer (PBO) software, which required BLC modifications, 

optimization/solver changes to handle non-linear blend laws and enhancements to Profit Web Viewer (PWV) displays; 

2. Introduction of Flowsheet to distribute calculations across flow network, which includes a dynamic and continuous hybrid model allowing 

for discontinuities and tank hold-up with static non-linear elements e.g. blenders; 

3. The Proxy Limits calculations have been further enhanced to incorporate all the above; 

Profit Web Viewer (PWV) – the following improvements have been made: 

1. Lab Update is now supported; 

2. Profit Suite Operator Station (PSOS) to PWV theme file migration is now supported; 

3. PWV themes are enhanced to include multiple trend, summary, detail views and configurable environment settings e.g. colours at a 

global or scope role; 

4. PWV PEx displays now include a Process Display for the configured PEx Flowsheet; 

5. PWV themes developed in older releases can be migrated to R502; 

Profit Suite Engineering Studio (PSES) – obviously changes required for PEx improvements, but also DMC Converter improvements to handle 

higher order models and settling times problems. 

Profit Suite Runtime Studio (PSRS) – changes are made for PEx to allow the hybrid model-based platform to be built and configured, which 

includes BLC connections to/from the Flowsheet. 

Infrastructure – infrastructure and configuration changes required for PEx communications to/from PBO have been implemented, but also the 

following 2 improvements are key: 

1. New Input/Output OPC logging feature, which records all OPC reads/writes for all platforms, and for Profit Controller application and 

MV statuses are also logged. The log is configurable either for max disk space and/or time span limited; 

2. Flexera Licensing Improvements include one-time entry of multiple activation IDs in one bin file, whose validity has been extended 

from one to four days to allow for over weekend activations; 

Honeywell Intuition Core Components R292 – is provided as a separate install to support TLS 1.2, which is only necessary if Profit Web Viewer 

is installed and is being actively used; 

R502 Functional Release Specifics – Profit Suite™ R502.1 has been released and is available for download on the Honeywell Process Solutions 

Support Website (http://www.honeywellprocess.com). R502 consists of four files: 

Profit Suite R502.1.exe – this is the main patch for the Server and Client sides and should be installed wherever Profit Suite R500.1 has been 

installed. Since R502 is a cumulative patch it includes all R501 features/fixes, so there is NO need to install R501 before installing R502; 

Profit Suite R502.1 DMZ.exe – Used for L4 access. This patch is installed on a clean Windows Server node located in DMZ when there is no trust 

relationship between L4 and DMZ network. If Profit Suite R501.1 DMZ patch is already installed there’s no need to install the R502 DMZ patch; 

http://www.honeywellprocess.com/
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Profit Suite Documentation R502.1.exe – the R502 documentation patch, which should be installed on nodes where Profit Suite R500.1 has 

been installed; 

Honeywell_Intuition_Core_292.zip – Intuition Core software must be upgraded to IC292 for Profit Web Viewer R502 to support TLS 1.2. Note 

that this installation (that cannot be rolled back) is separate from the Profit Suite R502.1. This IC292 MUST be installed on ALL nodes where 

R500.1 Profit Web Viewer has been installed BEFORE installing Profit Suite R502.1; 

In addition, there is a Profit Suite R502.1 Software Change Notice.pdf. Please note this SCN is under Latest Documentation and the four part 

Patch under Latest Downloads accessible by just searching on Profit Suite R502. 

 

Profit Suite PS R442.1 Patch001 

The Profit Suite™ PS R442.1 Patch001 has been released and is available for download on Honeywell Process Solutions Support website 

http://www.honeywellprocess.com. 

The patch addresses problems and offers improvements requested since the release of Profit Suite R442.1 as described in the patch SCN 

document available on the Support page of the Honeywell Process Solutions website, but specifically three main issues are addressed: 

1. The previously selectively released PS R442.1 Profit Optimizer Patch001 is now included within this single R442.1 Patch001; 

2. The previously selectively released PS R442.1 UOPCokConTkUpdate Patch001 is now included within this single R442.1 Patch001; 

3. Following a review of the R501 PAR fixes 20 of them have now been re-applied and fixed in this R442 Patch001; 

In conclusion, this PS R442.1 patch consolidates two previously selectively released R442 patches and with over 20 fixes from R501 allows 

customers to stay on R442 without a full R500 media release upgrade and retain ULM licensing if so desired. 

Please Note: this patch is for and should be installed after Profit Suite R442.1 only, but it can be installed over the top of or instead of the Profit 

Optimizer or UOPCokConTkUpdate Patch001s. 

The patch consists of two files (Patch and SCN): 

PS R442.1 Patch001.exe – this is for Profit Suite R442 Server and Client installations. 

Please note the SCN is under Latest Documentation and the Patch under Latest Downloads accessible by just searching on Profit Suite R442. 

For more information on Profit Suite™ or to place a software order, please contact your Honeywell account manager or email: 

HPS Technical Support Contact Information: 

• apc.apptech@honeywell.com for North and South America regions; 

• apc.support.emea@honeywell.com for Europe, Middle East and Africa and Asia Pacific regions; 

  

http://www.honeywellprocess.com/
mailto:apc.apptech@honeywell.com
mailto:apc.support.emea@honeywell.com
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TaiJiPID R310.2 Patch is now available for download 

The TaiJi™ PID R310.2 Patch fixes the following three historically long standing High Priority Product Anomaly Reports (PARs). 

1-8XU2LA5 - When a PID loop is taken for Step Testing the preset SP test limits defaults to the SP Limits, this has now been resolved; 

1-87RSMGI – TaiJi tuning is incorrect, this has now been resolved; 

1-7X3V3JB - TaiJi browse for OPC tags does not provide the correct OPC tagname when importing data from OPC HDA, this has now been 

resolved; 

In addition, although the PAR # 1-A68COZ1 - Unable to install TaiJi Tuning Service in Windows Server 2016 operating system, which would 

require a full media release, has not been fixed, the workaround to achieve this has been documented in the Knowledge Article 

TAIJI:310:0022/19 – ‘How to install TaiJiPID on Windows Server 2016 operating system’ available on the web portal. 

The R310.2 Patch and the Software Change Notice are both available for download from the Honeywell Process Solutions Support Website 

(http://www.honeywellprocess.com). 

For more information on TaiJi™ and CPM™ or to place a software order, please contact your Honeywell account manager or email: 

HPS Technical Support Contact Information: 

cpm.support.emea@honeywell.com for all global queries. 

Back Home 

 

  

http://www.honeywellprocess.com/
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Control Performance Monitor (CPM) Knowledge Article Quarter: Summary of Articles – 4Q19 (to end 

December) 

Please refer to the September 2018 BG Newsletter for all the details regarding this CPM Knowledge Article Quarter series and this quarter we 

publish the Summary of Articles for 3Q19 to date on the portal below: 

 

Final note on KAs is the above tables show only the public published articles, however on rare occasions there is a need to share 

internal/confidential KAs within Honeywell and these are not published publicly, although they also have Article ID numbers, which might 

account for gaps and apparent missing article numbers. 

For more information on CPM™ please contact your Honeywell account manager or email: 

HPS Technical Support Contact Information: 

cpm.support.emea@honeywell.com for all global queries. 

Back Home 

  

mailto:cpm.support.emea@honeywell.com
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Current Product Releases 

Advanced Applications: 

DynAMo Alarm Suite R202 

• Metrics & Reporting 

• Documentation & Enforcement 

• Alerts & Notifications 

• Process Safety Analyzer 

 

DynAMo Operations Suite R230 

• Operations Management 

• Operations Logbook 

• Limit Repository 

 

UniSim 

• UniSim Design R461.1 

• UniSim Competency R461 

 

Business FLEX R250 

• Ongoing support for Uniformance PHD 215, PHD 300, PHD 310 and PHD 320 

as well as PI and other OPC HDA-compliant historians 

 

Profit Blending and Movement (PBM) Solution 

Profit Blending and Movement (PBM) R500.1 

• Blend Performance Monitor (BPM) 

• Experion Blend Controller (EBC) 

• Experion Tank Monitor (ETM) 

• Profit Inventory Monitor (PIM) 

• Profit Blend Controller (PBC) 

• Profit Blend Optimizer (PBO) 

• LIMS Viewer (LV) 

• Profit Movement Management: 

➢ Movement Monitor (MM) 

➢ Movement Control (MC) 

 

Energy Dashboard R241 

• Integrated suite to calculate and monitor actual and target energy use. May 

include Operations Monitoring, Profit Sensor Pro, UniSim Design, and 

Workcenter. 

 

Workcenter 

Web-Based Visualization Analysis Solutions 

• Workcenter Release 242 

 

Matrikon OPC 

• Matrikon FLEX OPC UA SDK - R400.2 

• Matrikon OPC UA Tunneller 

 

Profit Suite 

• Release R442 

 

Uniformance 

• Uniformance PHD 400 

• Uniformance Process Studio R322 

• Uniformance Asset Sentinel R511 

• Uniformance Insight R210 

• Uniformance Cloud Historian R122 

• Uniformance Executive R310 

• Uniformance KPI R121 

 

Symphonite Supply Chain and Production Management 

• Production Manager Release 9.0 

• Production Accounting and Reconciliation R210 

• OptiVision R541 

 

Digital Suites for Oil and Gas 

•  DSOG R100 including Process Safety Suite, Production 

Surveillance Suite, Equipment Effectiveness Suite 

• Production Surveillance Well Test R110 

 

Control Performance Monitor 

• CPM CX R110 

• CPM Standard R602.1 

• TaiJi PID R310 

 

Honeywell Pulse 

• Release R110 

 

Back Home 
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Contact Information 
 

Americas Support Centre Contact Information 

Advanced Alarm Management (DynAMo/AAM Suite) opsHelp@honeywell.com 800-822-7673 

Advanced Planning and Scheduling (APS) support@honeywell.com  +403-216-2870 

Blending & Movements (PBM/OM&S) Support rac.support@honeywell.com +1-289-333-1500 

OptiVision Help Desk optihelpgroup@honeywell.com +1-513-595-8944 

Profit Suite Support apc.apptech@honeywell.com 1-800-822-7673 

Technical Assistance Centre (TAC) – Americas  1-800-822-7673 

Uniformance Help Desk support@honeywell.com +1-403-216-2870 

UniSim Design Suite Support UniSim.Support@honeywell.com 1-800-822-7673 

UniSim Competency Suite Support hpscustomersupport@honeywell.com 1-800-822-7673 

 

Asia Pacific (AP) Technical Assistance Centre (TAC) for Advanced Solutions contacts 

Advanced Process Control Support apc.support.ap@honeywell.com  

Manufacturing Execution Solutions (Includes APS, BMA, MES, 

OMPro, AAM and Uniformance PHD) 
bflex.support.ap@honeywell.com   

OptiVision Help Desk p3its_oncall@honeywell.com + 358 20752 2300 

Profit Blending and Movement (PBM) Solutions Support bma.support.ap@honeywell.com  

UniSim Support unisim.support@honeywell.com  

UniSim Competency Suite Support hpscustomersupport@honeywell.com  

 

Honeywell Asia Pacific regional GCCC hotlines: 

Australia GCCC.Pacific.HPS@Honeywell.com 1 300 301 135 

China: 400-820-0386 800-820-0237 

India:  1-800 2335051 

Indonesia:  0018-03-440-212 

Malaysia:  1 800-812-674 

New Zealand:  0800 855 663 

Pacific (outside Australia and New Zealand):  +65 6787 1788 

Philippines:  1-800-1441-0223 

Singapore:  6823-2215 

Taiwan:  0800-666-051 

Thailand:  0018-004-415-283 

 

Europe and Middle East and Africa, (EMEA) Technical Assistance Centre (TAC) for Advanced Solutions contacts 

Control Performance Monitor (CPM) CPM.support.emea@honeywell.com  

Alarm Management (DynAMo/AAM) DynAMo.support.emea@honeywell.com  

OptiVision Help Desk p3its_oncall@honeywell.com + 358 17 57 89 300 

 

EMEA Advanced Solutions Helpline  +32 (0)2 728 2200 

Advanced Process Control& Optimization apc.support.emea@honeywell.com  

MES BusinessFlex mes.support.emea@honeywell.com  

Production Control Centre kunde@honeywell.com +47 6676 2180 

Profit Blending and Movement (PBM) bma.support.emea@honeywell.com  

UniSim Competency Suite Support hpscustomersupport@honeywell.com  

UniSim Support unisim.support@honeywell.com  

   

Automation College www.automationcollege.com  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For questions, comments or archived copies of 

the Guardian newsletter, please contact 

Sandhya Karnam at 

Sandhya.karnam@honeywell.com. 

Honeywell Process Solutions 

1250 West Sam Houston Parkway South 
Houston, TX 77042 
 
Honeywell Control Systems Ltd, Honeywell 
House Skimped Hill Lane Bracknell RG12 1EB 
 
555 Huanke Road, Zhangjiang Hi-Tech Park, 
Shanghai, China 201203 

 
www.honeywell.com/ps 
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